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FCC STATEMENT 

Note: 
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation 
reception, which can be determined by turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the following measures: 

Reorient or relocate the receiving antenna. 
Increase the separation between the equipment and receiver. 
Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected. 
Consult the dealer or an experienced radio/TV technician for help. 

The use of shielded I/O cables is required when connecting this equipment to any and all 
optional peripheral or host device. Failure to do so may violate FCC rules. 

Caution: 
Changes or modifications not covered in this manual must be approved in writing by the 
manufacturer’s Regulatory Engineering Department. Changes or modifications made without 
written approval void the user’s authority to operate this equipment. 

Responsible Party 
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1 Introduction 

1.1 Components 

TURNING ON YOUR EXILIEN 101
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1.2 AC adapter 
The AC adapter let you connect to AC power through a power outlet. 
The set starts charging the internal battery  automatically instead of using its internal 
battery pack. When charging the battery, the battery charge light shows the battery 
charging status. 

1.3 Connecting to your PC 
If you plan to share data between the set and your PC’s PIM(personal information 
manager program such as Microsoft Outlook), you should connect the set to your PC.  

1.4 Connecting the Cradle(option) 
The cradle comes optionally with your device . 
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2 Basic Application 

2.1 Internet 

2.1.1 Wep browser (atilla )

Atilla is internet browser that support HTTP1.0 protocol and use HTML4.0 documents. 

2.1.2 E-Mail ( )

If you operate mail icon, you can see receiving messages on the window. And, if you 
touch the receiving message title, read mail is displayed on the window. Then, you can 
know date, time, subject and contents as well who sent. 
If you want to send a mail to someone, touch the icon of sending mail at the upside of left. 

2.2 PIMS (Personal Information Management System) 

2.2.1 Today ( )

The Today helps management of your schedule or working. It helps you can organize 
schedules and working “To do” from important to non-important things. 

2.2.2 Address Book ( )

The Address book helps you to keep all your contact names, address, phone numbers and 
details about the contact in one file. 
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2.2.3 Scheduler ( )

The Scheduler helps quickly and easily schedule appointments or any kind of activity 
associated with a time and date. 

2.2.4 To Do List ( )

To Do List is a convenient place to create reminders and prioritize the things that you 
have to do. 

2.2.5 Memo Pad ( )

Memo Pad provides a place to take notes that are not associated with records in other 
PIMS. You can take notes with your stylus pen in the same way as writing on paper in the 
memo pad. 

2.3 Utility 

2.3.1 Search ( )

S/W for searching files and name at the upside of left when window is opened. 
You can search contents among all(searching all data), address,  schedule, to do, memo 
and file. 
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2.3.1 Calc ( )

Calculator enables you to perform addition, subtraction, multiplication, and division. 

2.3.2 Terminal ( )

For function to choose and to set input console mode 

2.3.3 Wclock ( )

You can see world time of which you want to know. 

2.3.4 File Browser ( )
You can browse files in directories 
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2.4 Entertainment 

2.4.1 Media Player ( )
You can play MP3, MPEG-1 and MPEG-2 files. After playing, you can see some contents 
such as index no. of MP3 file, the status stick of play, Play/Pause/Stop button icons, etc. 

2.4.2 Image Viewer ( )

You can see image files such as JPG, GIF file, etc on the window and there are functions 
such as image enlargement, reduction and rotation 
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3 Basic operation 

3.1 Tapping 
Tap with the stylus to get things done. 
Like using a mouse to click elements on a computer screen, using the stylus to tap 
elements on your device screen is the basic action that gets things done on your device. 

Important : Always use the point of the stylus for tapping or making strokes on the set screen. 
Never use an actual pen, pencil or other sharp object to write on the set. 

3.2 Calibration screen 

The first time you start your device, a calibration screen appear on the screen. 
Calibration aligns the internal circuitry of your device with its touch-sensitive screen so that 
when you tap an element on the screen, the set can detect exactly which task you want to 
perform. 

3.3 Applications Launcher

Your device is equipped with a variety of applications. All the applications installed on your 
device appear in the Applications Launcher. 
You can use the Applications Launcher to open any application. Tap the icon of the 
application or folder that you want to open. 

* Basic applications and folders structure 
Application Text viewer  

Game Minesweet 
Solitaire 

Tetris 
Internet E-mail 

Atilla 
MultiMedia Image viewer 

MP3 Player 
Media player 

My Document   
Setup Network Network 
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PPP 
 Personal Alarm 

Owner 
Password

 System AppRemover 
Backup

Brightness 
Calibrate 

Power 
Rotation

Sync 
System 

TaskManager 
Time 

Volume 
Utility Calculator 

File Browser 
Terminal 
WClock

Address 
Memo 

Schedule 
ToDo 
Search   

3.4 Typing 

You can enter data into your device using onscreen keyboard, character recognition. 

3.4.1 Using the onscreen keyboard 

The onscreen keyboard is easy to use by tapping the character you want to write on screen. 
Open the onscreen keyboard using the icon anytime you need to enter text on your device. 
You cannot enter handwriting characters in screen keyboard mode. 
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3.4.2 Using character recognition 

You can also use the character recognition software to write. When you write a letter in 
the box, your handwritten character is converted to typed text that appears on the screen. 

Recognizable character group is as below. 

Korean : 2,350 characters (excluding several special letters) 
English : Alphabet 26 (including capital letters and lowercase letters) 
Number : 0 ~ 9 
Symbol : Special symbols which are recognized by Keyboard 
 ~ ! @ # $ ^ & * ( ) = + [ ]   ; : < > , . ? / \par gesture: Special definition data input 
pattern to edit sentences 

In order to input character by character recognition screen,  tap screen by stylus pen after 
locate cursor where input data, then character recognition screen appears automatically. If  
screen keyboard came out, change the data input mode from screen keyboard mode to 
handwriting recognition mode by tapping handwriting recognition button. Coming-out 
recognition screen is divided into two of  vertical sections, write a letter per screen 
respectively by stylus pen.  

Tip : In the case of handwriting input character recognition,  input letters as large as you can 
by correct character in order to improve accuracy 



12

4 X-Sync 

4.1 Installing X-Sync Desktop software 
You can synchronize information between your device and your desktop computer to 
make sure both computers have the latest information. First you’ll need to install X-sync 
on your desktop computer. 
You can also use X-sync software to back up and restore your device data, to add and 
remove programs on your device, and to copy files between your device and your desktop 
computer. 

Follow the installation procedures in the order given here to install X-sync, connect your 
device to your desktop computer, and establish a partnership for synchronization. 

USB Driver Installation 
1. Connect the your device to an available USB port in your desktop computer. 
2. If your desktop computer prompts Found New Hardware, then follow the instructions 

to install USB driver. The device driver files, EX_USB.INF and EX_USB.SYS, are 
located in the CD-ROM. 

Installation the X-sync Manager 
1. Insert the compact disc into your CD-ROM drive. 
2. Type D:/setup, where D is your CD drive. 

3. Click Next to set up. 

4. Select the Destination Folder you want to install the software in, and then click Next. 
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5. Select the Working group you want to install the software in, and then click Next. 

6. Click Finish when you done installation. 

Launch X-sync Manager 
1. Click X-sync icon on the main menu. 

2. You can see the X-sync manager window. 

4.2 Function and setting of X-Sync 
X-Sync synchronize information between your device and your PC by USB or serial. PIMS 
data such as Address, schedule, To do, Memo etc are synchronized with Microsoft Outlook of  
Windows, User  can control these PIMS data selectively.  X-Sync’s configuration is as below. 

1. In order to connect device with PC, need to assign communication port. Tap [Tools] -
> [Options] at Memu bar of X-sync or choose the last icon at upper tool bar 
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2. After choosing the first item tap (Sync Method), choose your device’s connection 
method . In the case of connection by USB cable, choose Use USB, in the case of 
connection of serial cable, choose Use serial. 

- If you chose Use Serial, input serial port number of PC. Generally, it is Com1 
or Com2. If Modem or a device which used serial port is installed in PC yet, 
install except the prior installed modem port or Serial port. 

3. Choose Sync rule tap of upper taps. You can set up which synchronization is base 
between device base and Outlook’s data base. The each meaning is as below. 

     
- Compare modification time : Compare the time that data are saved between 

device and PC data, the latest data replace the old data. Generally, if user 
chooses this mode, user can maintain the latest data anytime because device’s 
data  or PC’s data, only one side’s data are modified 

- Always replace the item on my device : Base on PC’s data, device’s data are 
changed. So, PC’s data overlap device’s data. 

- Always replace the item on this computer : Base on device’s data, PC’s data 
are changed. So, device’s data overlap PC’s data. 

4. And then, choose Sync mode tap at upper tap. User can set up the method of 
synchronization between device and PC. The each meaning is as below. 
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- Only upon connection : Automatically operating on connection of device and 
PC.

- Manually : After connect of device and PC, user have to tap sync icon to 
synchronize device and PC. 

But, this setting is available in base on USB cable connection. If connection method is Use 
Serial at Sync Method tap, there is displayed that Sync Mode is not available. User have to 
tap Sync icon to operate synchronization manually. If user finish to set up all options, tap OK 
button.

4.3 Sync
1. In order to synchronize device’s data and PC’s Outlook’s data by X-Sync, first of all, 

choose which option is synchronized. 
Operate X-Sync to tap X-Sync icon on Basic screen or double click X-Sync manager on 
working tray. Check options which user want to choose at Main screen. All chosen options 
are synchronized with Outlook’s related applications. The items are as below 
 Device    Outlook  
 Address   ------------------- Address Book 
 Schedule ------------------- Schedule 
 Memo     ------------------- Memo 
 Todo    ------------------- Work 
 Mail    ------------------- Incoming box 

2. If device is connected by USB and Sync Mode is set Only upon connection up, it is 
connected to PC under the device power turn on, synchronization operate 
automatically. If  device is connected by Serial or Sync mode is set Mutually up in 
case of USB, user have to tap X-Sync’s [File] -> [Synchronize] or tap the first icon at 
upper tool bar to start synchronization. 

4.4 Installing and removing applications 

4.4.1 Installing add-on applications 
Your device comes with the applications installed and ready to use. You can also install 
additional applications on your device, such as games and other software. 
To learn more about these applications, go to the wep site : http://www.hntek.com.
Note : Any game or application that you install on your device resides in memory, you can 

delete them at any time. 
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To install add-on software on your device : 
1. On your computer, copy or download the application you want to install into the any 

directory. 
2. Double click the X-Sync icon( ) on your desktop. 
3. Click install manager. 

4. Click install( ).
5. Select the application that you want to install on your device. 

Tip : You can also access the Install Tool Dialog by selecting Install Tool or by double-
clicking any file with a MIP file extension. 

6. Click open. 

Note : Review the application you selected in the Install Tool dialog box. If you do not 
want to install an application, click No. 
7. Click Yes. 
8. User can see the install status of applications by bar graph. 

9. After installation complete, user can see a message “Application install has been  
succeeded.”. Then Click OK. 

10. User can see “Tetris” icon at Install Manager screen and Tetris game is installed in 
Game folder. 



17

4.4.2 Uninstalling applications 
Use Install Manager of X-sync to uninstall application which is installed in device. 

a. Connect device and PC by USB or serial cable. 
b. Operate PC X-Sync. 
c. Tap [Tools] -> [Install Manager]  of X-Sync or tap the icon of upper tool bar to 

operate Install Manager. 

d. User can see applications’ list installed in device at lower screen of Install Manager. 
Example, uninstall Tetris game. 

Choose the application user want to uninstall and check in check box. Tap [Tool] -> 
[Remove] of Install Manager screen or the second icon of upper tool bar. 
e. User can see a question message whether user will uninstall the application chosen or 

not. Then, chick Yes. 

f. After a message which uninstall completed successfully, click OK. 

g. User can see that Tetris game is uninstalled at Install Manager screen. 

TIP : Other application uninstall method is [Setup] -> [System] -> AppRemover except to use 
Install Manager. Usage of AppRemover, refer to 5.3.1 System setup. 
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4.5 Other function of X-Sync 

4.5.1 Remote File Browser 
Remote File Browser is a function to manage files of device by X-Sync. User can copy, move, 
remove files by this function and manage folders. 

1. Connect device with PC by USB or serial cable. 
2. Operate X-Sync of PC. 
3. Tap [Tools] -> [Remote File Browser] of X-Sync or the icon of upper tool bar to 

operate Remote File Browser. 
4. Because Remote File Browser’s function is same as general file manager of PC, the 

usage is same as PC’s. The left screen shows user the current directory structure, the 
right screen shows the directories’ internal file(s) and directory. 

5. At Remote File Browser , if user use the right button of mouse, user can works more 
easily. If the right button is clicked, user can see as below sub-menu and operate the 
related work. 

4.5.2 Synchronize Time 
A function to synchronize device’s time and PC’s time, it is for calculation of the exact time 
for data synchronization. 

1. Operate X-Sync of PC. 
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2. If click [Tools] -> [Synchronize Time] of X-Sync or click the icon of upper tool bar, 
user can see a message of device time synchronization. Then click O.K. 

3. After Sync Time setup, user can see a message of time synchronization success. Then 
click O.K. Device’s time and PC’s are synchronized. 
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5 Customizing your device 

In order to use device easily and conveniently, user have to set up options according to user’s 
likings and environment. In addition, user can set up options to connect internet by network 
and telecommunication environment, it is available to be convenient for security of private 
information and system by password setup. These system setup is available by checking 
checking of setup icon in Main screen. 

5.1 Network setting 
The Network setting enable you to use the TCP/IP software that is included in the device 
operating system. You can use the TCP/IP software to connect with Internet Service Providers 
(ISPs) or dial-in (remote access) servers. Because the TCP/IP software is a feature of the 
operating system, you configure all parameters relating to it from the setting. 
To use TCP/IP, you must configure both the Modem and the Network settings. 

5.1.1 Network setting 
1. Network setting is divided into Network and PPP. User who use Ethernet card in LAN 

(Local Area Network) environment  choose Network, user who use telephone modem 
choose Modem. 

2. LAN environment’s user choose Network, input IP address and Gateway, DNS, etc. 
manually. Especially, if user is assigned has Host name, Domain and IP address, 
choose User Specific IP Address, input exact data respectively. If it is DHCP 
environment which use IP address allocated automatically, choose Use Server-
assigned IP Address, then user do not need to input specific data to use internet. If user 
do not know network information, inquire network information to network manager. 

5.1.2 PPP setting 
1. In case of user who use Modem, choose PPP and set up PPP environment (network by 

telephone). There is blank screen when PPP is chose. For the sake of new PPP setup, 
choose [File] -> [New]. 
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2. New PPP  setup screen appears. Input data to meet ISP at each item. If  you do not 
know input-data, inquire exact data to ISP. After finishing data input, click O.K button 
and close PPP setup screen. 

3. Modem setup installed at device is set up at [File] -> [Option] of PPP Main screen 
menu or set up to click the icon of upper tool bar regarding modem install port, 
modem information, initialization commander, etc. After finishing all data input, click 
O.K button and close setup screen. 

4. After finishing setup, summarized contents of PPP setup is displayed. Click the first 
icon of upper tool bar, then dialing and PPP connection is configurated. 

5. In case to Modify, remove PPP setup or add new PPP environment Setup, click full 
down menu of the left of upper tool bar. 

5.2 Personal setting 
Personal setting is to assign user information, user designated alarm, password, etc. 
In order to set up personal setting of device, tap [Setup] -> [Personal] icon of Main screen. 
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5.2.1 Alarm setting 
1. For user alarm setup, choose Alarm icon. 

2. If alarm setup is chosen, there is blank screen. In order to setup new alarm, choose the 
icon of upper tool bar. 

3. Input exact data at each blank box. When user input alarm title, user can use 5ea of 
prepared title or can input title manually.  

4. Set up repeat option and alarm start and finish date. Alarm repeat could be set up in 
order of day, week, month and year and user can set up to finish alarm after given 
period or can repeat alarm forever till setting up again. If user finished all data input, 
click O.K button at the upper of right to save setting data. 

5. According to same method, if set up several alarm, alarm list is displayed at alarm 
initial screen. 

6. Alarm Type is for setting of backlight operating when alarm is ringing,  Play Sound is 
the setting of alarm notice by sound. If Play Sound is chosen, user can set up alarm 
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sound at popup list of lower. If  Play button of the right of popup list is touched, user 
can listen to the sound chosen beforehand. 

7. When alarm is operated, user can see alarm screen as below. 

5.2.2 Owner setting 
1. For user owner setup, choose Owner icon. 

2. Input exact data. The owner enables you to record a name, company name, phone 
number, or any other information that you want to associate with your device. 

5.2.3 Password setting 
1. User can set up password for the sake of device security. 
2. For the sake of  password setting, user choose Password at Personal setting screen. 

3. Set up password by four-figure number. After setting of password, device require 
password when device information need to be changed. If user set up Require 
password when device is turned on option of lower, device identify user after 
recognition of password when device turn on.  
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5.3 System setting 
In order to set up device system setting, choose System option after click Setup icon at main 
screen.

      

5.3.1 AppRemover 
Remove function of application which is installed at system memory according to user 
choice. Removable application is limited to application user installed, user can not remove 
arbitrarily the applications pre-installed when device is commenced from factory. 

5.3.2 Backup 
Problem for the sake of backup of application data, program setting files and data installed 
in device, in order to save data at Compact flash or other external memory. Also, user can 
recover backup data by this utility. 

5.3.3 Brightness 
User can control screen brightness and backlight usage. Backlight is related to battery 
consumption, so if user control the lightness, user can lengthen the time of battery usage. 
Also, user can set up backlight to turn off automatically if device is not used for a 
specified period of time.  



25

5.3.4 Calibrate 
Touch panel calibration aligns the internal circuitry of your device with its touch-sensitive 
screen so that when you tap an element on the screen, the your device can detect exactly 
which task you want to perform. 

You may perform Touch Panel Calibration when the touch panel is out of synchronization. 
It is very important for correct calibration to touch the exact center of the calibration 
symbols every time. Touching wrong place of calibration symbols may cause 
synchronization problem during the touch panel operation. 

Perform the following message respectively. 
1. Please touch the center of the mark in the upper-left corner. 

2. Next touch the center of the mark in the lower-left corner. 

3. Next touch the center of the mark in the lower-right corner. 

4. Next touch the center of the mark in the upper-right corner. 

5. Finally, touch the center of the mark in the center of display. 
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5.3.5 Power 

Battery remaining time is displayed and user can set up device to turn off automatically if 
device is not used for a specified period of time. User can set up the battery interception 
time from one minute to five minutes according user’s choice. In the case that user use 
external battery also, user can control the battery interception time from one minute to 
five minutes when device is not used for a specified period of time to protect device from 
damage. 

5.3.6 System 

Using memory status of device and available remaining memory status are displayed as 
well as system usage status and system version. 

5.3.7 TaskManager 
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Operating application contents are displayed and user can control remaining memory 
quantity by optional close or whole close. 

5.3.8 Time 

Setting of device’s time and date. Because setting time and date chosen are connected 
with Linu@ applications’ time and date, exact time and date setting is very important. 

5.3.9 Volume 

Setting of device’s sound volume. User can control effect sound, alarm and hardware 
button’s  usage effect sound as well as Multimedia sound. 
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6 PIMS 

6.1 Address book 
On your way to the meeting, you stop at a café for coffee. You run into a designer you’ve 
worked with who is now working for a new firm. You take out your device and enter your 
colleague’s information, with no risk of misplacing it. 

The main function on Address Book 
It displays data listed by name or contact point. 
It provides the fast searching with entering the first character of the name you want to 
find. 

Enter new information 
1. Tap the New button at the menu bar to create a new contact record.( )
2. Tap the screen where you want to enter data. 
3. Type data using the onscreen keyboard or the handwriting method. 
4. Tap the OK button 

Edit the recorded information( )
1. Tap the contact to update. 
2. Tap the screen where you want to update. 
3. Type the data using onscreen keyboard or handwriting. 
4. Tap the OK button. 

Cancel the editing 
1. Tap the Cancel button during NEW or EDIT operation. 
2. Device displays address book list view windows. 

Deleting contact information( )
1. Select a contact to remove from the record. 
2. Tap the Delete button. 
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3. A dialogue box to confirm the delete command will be displayed. 
4. Tap Yes button. 

Searching a string in the address book( )
1. Tap search button on the menu bar or select search under the edit menu on the title bar. 
2. Type the search characters using onscreen keyboard or handwriting. 
3. Tap the find button 

 Click the icon at main screen, then Address is operated. 
1. If Address option is chosen, blank screen is displayed. In order to add new Address 

contents, choose the icon of upper tool bar.  

2. Input exact data at each boxes according to necessary contents. If the small icon of the 
right, user can change field to wanted contents.  

3. When input data, user can input each address list in order category. In order to set up 
category, choose category full down menu of the upper of the right. User can modify 
and edit category according to user’s usage option.  
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4. It is a status that each boxes are filled out. Input data at necessary field, other 
unnecessary fields do not need to fill out. If all date are input, click O.K of the right 
upper and save data. 

5. Input person’s data according to above data input method. If all data are saved, 
person’s list is displayed at Address main screen.  

6. If user click Name at Address list, user can line up names in ascending or in 
descending, if user click Contents box, user can choose contents displayed of address 
list. When input address data, the first input data are displayed in basic. Also, user can 
display each list’ category and can line up in ascending or in descending at display list.  

7. If user set up only Mobile is displayed only, only Mobile number is displayed at list. 
8. If user tap a person to be needed to check, the person’s all data are displayed. 

9. Each data is synchronized with related utilities. If user tap Homepage address at a 
screen of personal information displayed . Web brower, Atilla operate automatically 
and contact the homepage. If user tap E-mail, e-mail program operate automatically 
and can write e-mail contents. 
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6.2  Schedule 
Before you say goodbye, you invite Lee to lunch next Wednesday. When you get in the car , 
you schedule the lunch on your device so you won’t forget. 

1.  Press the Schedule icon. Schedule  is an application to control personal daily schedule, 
appointment, meeting, memorial day, etc. In order to operate Schedule, tap Schedule 
icon at main screen. 

2. In order to add new schedule, move to the date of schedule, set up schedule from start 
time and finish time by drag of stylus pen. 

3. If user chose date and time, tap the icon of Schedule upper tool bar to create new 
schedule screen. Given time that is already dragged is automatically set up from start 
time to finish time at the new schedule screen. 

4. First of all, choose a new schedule’s title. If user tap full down menu of the side of 
Title box, five kinds of schedule form are displayed. In ascending, meeting schedule, 
lunch schedule, dinner schedule, visit schedule, telephone calling are displayed in 
order.
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5. User can edit schedules according choice of one of five kinks of schedule form. If 
user do not want to use these schedule form, user can input schedule title manually 
according to user’s taste. 

6. There is a list called Type at the lower of schedule title box. If user tap full down 
menu of  the right of Type box, five kinds of schedule form displayed. In ascending, 
appointment, meeting, telephone calling, others, memorial day are displayed in order. 
Choose the most fit schedule form. 

7. If user want to edit start time and end time, tap display full down menu of the side of 
the Starts and the Ends. Set up schedule  by. 

8. In order to set up alarm at a schedule checked, check the check box of the side of 
Remind me and choose a time when is alarmed before schedule start. 

9. Next, user write down necessary contents related with the schedule at Memo screen. 
10. Tap Attendant button to add new person in the schedule. There are person list 

registered at Address box of Linu@, choose one of them. 
11. Lastly, if the schedule is repeated, tap Repeat button to set up repeat setting. User can 

set up daily, weekly, monthly, annually repeated schedule, the start date and end date 
of repeat schedule, or the count of repeat. 
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12. If user set up irregular schedule such as memorial day, check all day of Time. Then, 
all day event without special arrange time is displayed.. 

13. User can set up category at each schedule and modify and edit category by user wants. 
Tap the small arrow of category box  to operate category edit screen. 

14. Screen  that one day schedule is input. Continual schedule all day is displayed  at the 
uppest of screen,  each schedule is displayed according to Type by color division. 

15. If tap the icon of upper tool bar, five days’ schedule are displayed except Saturday 
and Sunday. 

16. If  tap the icon of upper tool bar, one week’s schedule is displayed including Saturday 
and Sunday. 

17. If tap the icon of upper tool bar, one month’s schedule is displayed. The date 
scheduled is marked by a small square icon. 
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18. If tap the right icon of upper date display, all schedule list is displayed. 
19. If tap schedule list of each schedule screen, all contents related the schedule is output. 

6.3 To Do List 
You’re in a hurry to get to your meeting, but you want to remember to look for some 
architectural drawings you promised to show Lee at your lunch next week. 

1. Press the Schedule icon. User can control To do things or work list by an application 
called ToDo. Because it is not only to manage To do things and user can manage 
working operating period and importance range, etc., user can promote working 
effeciency. If tap Todo icon at main screen, this application operate. 

2. If Todo is chosen, blank screen without any list is displayed. In order to add new 
Address list, tap the icon of upper tool bar. 

            
3. Input exact data to each boxes according to title. Input working title and a working end 

date and start date, alarm, etc. 
4. Working process rate is displayed. If tap Status, user can choose process rate such as 

25%, 50%, 75%, Done, Delay or no display. 

5. Working importance rate is displayed. If choose Priority, user can choose among Low, 
Normal and High. 
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6. User can manage each working in order to category. In order to set up category, 
choose category full down menu. User can modify and edit category according to 
user’s mind. 

7. If finish all data input, tap O.K and save the data. Save Todo thing to be managed and 
working by same method. After saving all data, Todo thing and working list are 
displayed at Todo main screen. According to importance rate at the list, question mark 
is displayed. Low is green color, Normal is blue, High is red. 

                    

8. If user tap working that need to check at ToDo list, all data of the related working are 
displayed.  

9. Do check marking at the list of working finished to notice working finish. 
10. If user tap the icon of upper tool bar, unfinished working list are displayed.. 
11. If user tap Title at Todo list by stylus pen, user can line up working process status, 

importance rate, title and end date in ascending according to user setting order.  

6.4  Memo pad 
You arrive at your meeting early. You take this opportunity to take out your device and 

enter some key issues. 
You can take notes with your stylus pen in the same way as writing on paper in the Memo 
Pad. Memos are sorted alphabetically by title. 

To create a  new memo 
1. Press the Memo pad application icon on main menu to display the Memo Pad List. 



36

2. Tap the icon ‘New’ button.( )

3. Type data using the onscreen keyboard or the handwriting method. 

4. Tap the OK button 

Reviewing memos 
1. Tap the text in the Memo List. 

2. Tap the screen where you want to update. 
3. Type the data using onscreen keyboard or handwriting. 
4. Tap the OK button. 

 User can save necessary data by this application. User can save data such as image, voice 
recording  included memo as well as general memo, so user can write or save necessary data 
usefully. If tap the icon of Memo at main screen, Memo is operated. 

1. If Memo is chosen, blank screen without any list is displayed. In order to add new 
Memo, choose O.K icon of upper tool bar.. 

2. There is a screen to input new memo. If user tap the upper tool bar, user can see two 
icons, the icon means image memo and voice recording in ascending. First, let’s make 
a memo by character input. 

3. Input data that user want at the lower of memo working screen. The input data at 
Memo’s first line is the title of memo. 

4. User can manage each memos by category. In order to assign category, choose 
category full down menu of right upper. User can modify and edit the category by 
your mind. 
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5. In order to add image memo, choose the first icon of upper tool bar.  
6. At new memo screen, user can draw a image by user mind. If user have to change a 

image, choose eraser icon of the left upper, if use choose Clear all, all images are 
erased.  

7. In order to add voice recording memo, choose the second icon of the upper icon.  
8. Recording process status is displayed at lower of memo screen, tap stop icon to finish 

recording.  

9. Tap OK button to save voice recording memo. Save other voice recording memo by 
the same method. After finishing saving, the memo list are displayed at Memo main 
screen. Attachment icon is displayed if the saving memo is including a image data or 
voice recording memo.  

10. If user tap a memo that is needed to review in detail at memo list by stylus pen, the 
details are displayed. 
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a. The memo that attached image memo or voice recording memo is including 
attachment icon at memo details screen of upper tool bar. If user tap the icon, attached 
image or voice recording memo list are displayed. If user tap image memo or voice 
recording  by stylus pen, the image or the voice recording memo is displayed..  

6.5 Today 
Today is an application to display user’s schedule, meeting, To do, etc. daily. User can see all 
data of one day. 
In order to operate Toda, click Today icon at main screen.  

1. If Today is operated, the day’s schedule, memorial day, todo and new E-mail’s 
quantity are displayed by list type. If user tap a specific item, an application related 
with the specific item operate automatically. 

2. If user tap the icon of Today upper tool bar, a screen is displayed to choose items that 
are displayed at Today screen. User check data that are needed to display at Today 
screen or remove unnecessary data. 

3. Today do not only display a day’s event, but also list up event weely. Choose 
Day/Week of the right of upper tool bar for weekly list up. 
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7 Web browser
If it is connected with Internet after all communication environment setting, user can do web 
surfing by web browser operating only. Web browser, atilla do not only support HTML 4.0, 
but also JAVA script. User can use the most of websites same as user saw before by general 
PC.

a. In order to operate atilla, choose the icon of [Internet] -> [atilla] at main screen. 

b. If atilla operated, it is connected to internet site as Homepage assigned. 

c. If user tap the icon of atilla upper tool bar, user can see a wide screen that upper title 
bar and address input box are not.  

                                             
d. User can bookmark the website often visited, tap Bookmarks of upper tool bar 

                                             
e. If user tap Add Bookmarks..., a screen that bookmark the current page is displayed. 

Input exact URL and mark name and tap O.K button. 
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f. If user tap upper button and choose [Option] at menu, use can set up atilla options 
such as initial homepage and language encoding of website. Also, use can choose 
whether JAVA script operate or not. 
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8 E-Mail 
Device is including E-mail program with same as general E-mail client. E-Mail is working 

at Offline mode and Online mode generally, Offline mode is working without connection of 
internet, Online mode is working with connection of internet. 
In Offline mode, user can check mails received from PC’s Outlook by synchronization with 
PC. After message write-out, user can send E-mail by synchronization with PC. 
Also, in Online, user can send and receive E-mail whenever and wherever. 
In order to operate E-Mail, choose the icon of Internet -> E-Mail at main screen. 

8.1 Off-line E-Mail
a. E-Mail’s Offline means that user use E-Mail in the case that device is working without 

connection of internet. User can not send E-mail directly, but user can read mails at 
the status of saving in the device by synchronization with PC’s Outlook and send E-
mail that wrote out at device’s E-Mail by synchronization with PC. In Offline mode, 
in order to synchronize device and Outlook, check a mark in Mail list at main screen 
of X-Sync. 

b. If user tap the first icon of X-Sync’s upper, mails in receiving mail box with chosen 
other lists are also synchronized with device’s E-Mail. After synchronization 
completion, user can see that mails of receiving box of Outlook are saved at device’s 
E-Mail..

c. Current mails are saved at Inbox folder. User can see each mails’ content at mail list 
by tapping of stylus pen. 

Upper tool bar’s function that display mails’ contents is as below;. 
   : To reply to mail sender who sent current mail 
   : To reply to all people related with current mail. 
   : To forward current mail to other person. 
   : To see prior mail. 
   : To see next mail. 
   : To delete current mail. 
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d. Main box’s name is displayed at the right-upper of mail contents’ screen.  Mail box 
could be deleted or added according to user choice. Each mail boxes’ function are as 
below. 

Inbox : If user synchronize with Outlook by X-Sync, there is a place to copy 
mails of Inbox of Outlook.. 
Sent : A place to save mails that have sent. 
Outbox : In Offline mode, it saves new write-out mail temporarily, if device is 
synchronized, the mails move to the outbox of Outlook automatically and the 
mails are sent.  
X-Sync : A folder that synchronize with X-Sync folder of Outlook. X-Sync 
folder is made automatically when device synchronize with PC. 

e. To make a new mail on Offline. Choose the first icon of upper tool bar at E-Mail main 
screen. Then, new mail screen will be displayed. 

f. At From of upper, sender’s E-mail address is displayed automatically. This mail 
address is user’s mail address that user input at Setup-> Personal-> Owner. 

g. If user tap To button, address lists that are in Address are displayed, user can choose 
receiver’s E-mail address and send mail easily. If user want to send E-mail to a person 
who is not listed at Address list, input an E-mail address manually. According to same 
method, input address of reference person.  

h. If user tap Attach button, a screen that user can attach a file is displayed. Choose a file 
that is needed to send at this screen. If there is not a file that is needed to send, user 
can let it be blank. 

i. Mail’s status of contents input finished, tap O.K button of upper and save mail. 
j. Mail be saved at Outbox folder automatically, this mail move to sending box  

automatically by the time of synchronization and be sent. 
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8.2 On-line E-Mail
a. E-Mail’s Online mode means the usage of E-Mail in the case of connection with 

internet. In Online mode, user can write out our mail directly and receive new mail 
same as general E-mail client, for the sake of this setting, user have to set up mail 
accout. After operaing of E-Mail, choose [Option] of upper manu. 

b. A screen of new mail account setting is displayed. Then, choose the icon of upper tool 
bar. 

c. A screen of new mail account setting is displayed. Input the content of user’s E-mail 
service at each box. Device support IMAP4 protocol as well as POP3. After all data 
input, tap O.K button of upper and save data. 

d. After mail account setting and go back option screen, Tap upper tool bar and set up 
option. The each option is as below; 

* Receive only new messages : Only receive new mail, these are including POP3 server and 
IMAP4 server.  
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* Receive only headers : Only receive mail’s title, it is only for POP3. If a mail is not read by 
tapping of stylus pen, the mail is being saved at server. If user tap the mail title, the mail of 
the title is saved at Linu@. 
In case of IMAP4, only receive mail’s title. 
* Remove received messages from server : It is only for POP3 server, server is not including 
the messages after receiving messages from server. 
* Limit message size to : After checking of mail size, if it is bigger than setting mail size, 
device do not receive the mail.  
* Encoding : Setting of mail encoding. 

e. After saving of all messages, choose the icon of upper tool bar of E-Mail to send or 
receive mail. 

f. Writing method of new mail is same as Offline mode. Tap O.K button after new mail 
writing. The new mail is saved Outbox of E-Mail Online server and automatically 
operate sending or receiving when device is connected at internet or is synchronized 
with PC. 
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9 Media Player 
This chapter introduces you the media play technology, and explains general overview of 
media player. The media player stores your favorite MP3 and MPEG files in its flash memory 
so that they can be played any where you want to go. 

The device equipped with USB port to communicate with your desktop computer. You can 
download MP3 files to the device from your desktop computer using the X-sync software. 
You can download MP3 music files from numerous Internet sites or encode your own digital 
audio tracks from your own audio CDs using the CD-ROM drive on your PC. 

1. Obtain legal MP3 files from many MP3 Internet sites. 
2. Use the X-sync to download your MP3 files into the your device. 
3. Put your earphones on and press the Play button on the your device to listen the digital 

sound.

Operating Media Player 
Start 
Tap Media player icon in Multimedia folder. 

Media File Listing 
Tap to open MP3 Music Selection window. 
All MP3 files in the your device are displayed in the window. 
Check desired songs, or tap ‘All’ button to select the entire songs. You may tap ‘Reset’ 
button to deselect entire songs. 
Tap ‘Close’ button to return the MP3 player. 

Play 
Tap the track number you want to listen, or 
Tap the play button in standby or pause mode to start playing selected MP3 file. Operation 
indicator displays in play mode. 
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Pause 
Tap
It becomes pause mode by tapping in play mode. Operation indicator displays in pause 
mode. It resume the play by tapping again. 

Stop 
Tap
Stops playing MP3 file and reset play time counter when the MP3 player is in stop mode. 
The information of current music is displayed in new window. It displays title, musician 
name, album name, creating year, genre, track number, and comment. 

MP3 Player Track Shift 
Tap

Media Player is an application that plays multimedia file. Media Player plays MPEG and 
MP3, and because it support Skin function, usr can use only user own Media player by user’s 
mind. 

a. In order to operate Media Player, choose Multi Media -> Media player at main screen.. 
b. In order to make a play list, tap the play list button of the left of lower. 
c. Play List is displayed. Tap the icon of upper tool bar to add new media file to Play list.. 
d. After choice of media file that user want, tap check box of file name. If user finish all 

choice, tap O.K button of the right of upper to close Play list screen. 
e. User can see the file chosen that user want to play. Tap check book of file name to 

play the file that user want only. 
f. Play status of chosen file.  

g. If user tap the title icon of the left of upper, menu is displayed and user can set up 
sound quality control of audio, repeat play, random play, Skin setting of Media Player, 
etc. 
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10 Image Viewer 
You can see image files such as JPG, GIF file, etc on the window and there are functions 
such as image enlargement, reduction and rotation 

Image Viewer is an application that be able to display JPEG/GIF image file. User can enlarge, 
reduce, and rotate of image. Also, this application is including Full size view, slide show and 
wallpaper, etc. It is same as portable digital album. 

a. In order to operate Image Viewer, choose Multi Media -> Image Viewer at main 
screen. 

b. If user operate Image Viewer, blank screen is displayed. 

c. In order to open image file at Image Viewer, choose Open menu of main title bar or 
tap the icon of upper tool bar. Then, file viewer is displayed and user can choose the 
image file that user want to view. Tap check box of each image file and tap O.K 
button of the right of upper. 

d. The first image of chosen files is displayed. 
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e. If user chose several images, user can move backward and froward and see the images 
by tapping upper tool bar. 

f. If user tap the button of upper tool bar, use can enlarge and reduce image size. 
Enlargement is available by maximum three times, reduction is available by minimum 
size that screen can display on LCD.  

g. If user the button of upper tool bar, user can rotate an image. The rotation is 90 degree 
per one tapping of rotation button to time running direction. 

h. If user tap the button of upper tap, current displayed image is enlarged. If user want to 
restore the image to its former state, tap screen two times. 

i. If user tap the button of upper tool bar, chosen images are displayed by slide show to 
fit whole screen size in order. 

j. There are several setting menus at upper menu. 
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k. If user tap Wallpaper Setting, user can set up the current image as wallpaper. 

l. If user tap Options, user can control several setting that are used for image display and 
slide show.  

m. If user choose Fit to Fit of Display, user can set up that an image is fit to screen if the 
image size is bigger than scnree’s. 

n. If user choose SlideShow option, user can set up slide show’s rotation speed, rotation 
effect and image’s size to fit screen’s. 
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11 Text Viewer 
Text Viewer is an application that can read *.txt’s documents. User can read text documents 
such as novels, newspaper articles, tidy documents, etc. downloaded from PC or internet..  

1. In order to operate Text Viewer, choose Application -> Text Viewer at main screen. 

2. If user operate Text Viewer, blank screen is displayed.  

3. In order to open new text file, tap [Option] of upper title menu or tap the icon of upper 
tool bar. Then, a screen that chooses new text file is displayed. Tap check box of a text 
file that user want and tap O.K button of the right of upper. Then, the text file is 
opened. 

4. Documents’ moving is set up to move in a page by tapping hardware key or tapping 
upper or lower area of screen. Also, if user tap the button of upper tool bar, auto scroll 
function is operated that documents move to upper from lower automatically without 
any specific key operation. In order to stop auto scroll function, tap the button again.. 

5. If user move the slide bar of upper tool bar, user can move to the location of document 
where user want.  

6. If user tap the arrow icon of upper tool bar, use can set up bookmark at present 
location and it is convenient to move to the location chosen later. 
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7. If tap [Option] of upper title menu or the icon of upper tool bar, use can set up the size 
of screen and font, font color, bacground color, etc., and scroll’s interval and speed. 
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12 Other utility 
Anything else, there are many useful applications in device. Utility is displayed if user tap 
Utility at main screen. 

12.1 Calc 
Your device provides a Standard Calculator with a graphing feature. 

AC  : Clears the entire calculation and enables you to begin a fresh calculation.  
C : Clears the last number you entered. Use this button if you make a mistake 

while entering a number in the middle of the calculation. This button enables 
you to re-enter the number without starting the calculation over. 

MC : Clears any value that is stored in the Calculator memory. 
MS : Store current value to memory. 
M+ : Places the current number in memory. Each new number you enter with the 

M+ button is added to the total already stored in memory. The number that you 
add can be either a calculated value or any number you enter by pressing the 
number buttons. Pressing this button has no effect on the current calculation 
(or series of calculations); it merely places the value into memory until it is 
recalled.

MR : Recalls the stored value from memory and inserts it in the current calculation. 

12.1.1 % : Convert % value to real number(10%=0.1) 
+/- : Toggles the current number between a negative and positive value. If you 

want to enter a negative number, enter the number first and then press the +/- 
button.

12.2 File Browser 
A file browser that can manage directories and files in device 

.

12.3WClock
You can view the day and time for other cities anywhere around the globe by just tapping the 
city on the world map. 
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A utility that display three places’ local time in one screen. If user choose a place that user 
want to know the local time, the current local time of the city is displayed at lower. The map 
of Wclock could be displayed at two step by enlargement, then user can see and choose the 
city in detail. 
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13 Game 
Device is including several fun games in basic and user can download and install other 

games by internet. 

13.1 Minesweep 

13.2 Solitaire 

13.3 Tetris 


